PM5D Editor
Owner’s
Owner’s Manual
Manual

Special Notices

Contents

• The software and this owner’s manual are the exclusive copyrights of Yamaha Corporation.
• Copying of the software or reproduction of this
manual in whole or in part by any means is expressly
forbidden without the written consent of the manufacturer.
• Copying of the commercially available music
sequence data and/or digital audio files is strictly
prohibited except for your personal use.
• Yamaha makes no representations or warranties
with regard to the use of the software and documentation and cannot be held responsible for the results
of the use of this manual and the software.
• This disc is a CD-ROM. Do not attempt to play the
disc on an audio CD player. Doing so may result in
irreparable damage to your audio CD player.
• The screen displays as illustrated in this owner’s
manual are for instructional purposes, and may
appear somewhat different from the screens which
appear on your computer.
• Future upgrades of application and system software
and any changes in specifications and functions will
be announced separately.
• The company names and product names in this
Owner’s Manual are the trademarks or registered
trademarks of their respective companies.

Getting Started ......................................... 2
INPUT CH window .................................... 6
ST IN window ............................................ 9
FX RTN window....................................... 11
MIX window ............................................ 13
MATRIX window...................................... 15
STEREO window ...................................... 17
DCA window............................................ 19
Selected Channel window....................... 20
Patch Editor window ............................... 38
Surround Editor window......................... 42
GEQ window............................................ 44
Effect Editor window............................... 46
DCA/Mute Group window ...................... 50
Scene window ......................................... 53
Library window ....................................... 60
Meter window ......................................... 62
Timecode Counter window..................... 62
Sync window ........................................... 62
Keyboard Shortcuts................................. 63
Index........................................................ 64

* Specifications and descriptions in this owner ’s manual are
for information purposes only. Yamaha Corp. reserves the
right to change or modify products or specifications at any
time without prior notice. Since specifications, equipment
or options may not be the same in every locale, please
check with your Yamaha dealer.

❏ Yamaha Pro Audio Global Site
http://www.yamahaproaudio.com/

Description of menus and buttons
In the event that menu and button names on a Windows system are different from those on a Macintosh, this
manual uses the Windows menu and button names followed by the Macintosh menu and button names in parentheses.
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Getting Started
Overview of PM5D Editor
PM5D Editor enables you to remotely control the Yamaha PM5D mixing console and to save the parameter settings
on your computer. To use PM5D Editor, you must first perform the following operations:
1 Start and configure Studio Manager.
2 Start and configure PM5D Editor.
3 Synchronize PM5D Editor with your PM5D console ( ➥ p.3).
NOTE

For more information on using Studio Manager, refer to the Studio Manager Owner’s Manual.

Configuring PM5D Editor
You must configure the following settings for each open Editor.
NOTE

• Specify MIDI ports in the Setup window of Studio Manager before making the following settings.
• To open each Editor, double-click the icon of the console or device you want to edit.

❏ System Setup
To open the System Setup window, choose [System Setup] from the
[File] menu.
Be sure to specify the Input port and Output port.
Input port/Output port: From the ports you specified in
Studio Manager, select the ports that the editor will use to communicate with the PM5D console.
Console Device ID: PM5D Editor can control any one of up to
eight PM5D consoles, each with its own exclusive ID. Select the ID
of the console you want to control.
Channel Select: These options determine whether or not channel selection is linked. When the PC->Console option is on, selecting a channel in PM5D Editor selects the same channel on the
console. When the Console->PC option is on, selecting a channel
on the console selects the same channel in PM5D Editor.
Confirmation: These check boxes specify whether a confirmation dialog box will appear when you store (Store Confirmation), recall (Recall Confirmation), patch (Patch Confirmation), or make a patch change that would modify an existing patch (Steal Patch Confirmation).
Window Control from Console: This option determines whether or not using the USER DEFINED KEYS
on the console enables you to remotely open and close the PM5D Editor windows.
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❏ Console Setup
To open the Mixer Setup window, choose [Mixer Setup] from
the [File] menu.
Pair Mode: Select whether faders will be paired Horizontally
or Vertically.
Pan Nominal Position: Select whether the signal will be at
nominal level when panned to the center (Center) or when
panned all the way to left or right (L<->R). You can make separate settings for monaural channels and paired channels.
Bus Setup: Select the MIX bus mode (VARI/FIXED) for
every two adjacent odd-numbered/even-numbered MIX buses.
MIX buses assigned as surround buses are indicated as “SURROUND” and cannot be changed.
Surround Bus Allocation: Select the MIX buses (MIX 1–
8 or MIX 9–16) that will be used as surround buses.
Stereo B: Specify whether the same signal as the STEREO A
bus will be sent to the STEREO B bus (Stereo Bus), or whether
the STEREO B bus will function as the CENTER bus for LCR
mode (Center Bus).
Surround Mode: Select the surround mode (STEREO, 3-1,
5.1, 6.1).

Synchronizing PM5D Editor
When PM5D Editor starts up, the parameter settings on the console and the parameter settings in PM5D Editor may
be different. Therefore, you must first match the parameter settings on the console with those in PM5D Editor. This
operation is called “synchronization.” Follow the steps below to synchronize PM5D Editor.
1 Select [Synchronize], then [Re-synchronize].
The following window opens.
2 Select whether you want to transfer your settings to PM5D
Editor, or vice versa.
At this time, the All Libs option determines whether or not Scene and
Library data is synchronized.
PC -> Console: Transfers the current parameter settings in PM5D Editor to your console.
Console -> PC: Transfers the current parameter settings of your console to the PM5D Editor.
3 Click [OK].
Do not operate the console while synchronization is in progress.
NOTE

If you use the “Total Recall” function in Studio Manager, all selected Editors in Studio Manager are synchronized with the corresponding devices.

Offline Edit Function
If you do not want to synchronize your console with PM5D Editor, select [Offline Edit] from the [Synchronization]
menu. To apply your off-line edits to your console, select [Re-Synchronize] from the [Synchronization] with the PC
-> Console option to synchronize the console with PM5D Editor.
The Offline Edit function is also activated when you click the [ONLINE]/[OFFLINE] button in the Sync window.
NOTE

Some effect parameters in the console change their displayed values depending on the sampling frequency. If you switch PM5D Editor from OFFLINE to ONLINE, displayed parameter values may change
because PM5D Editor loads the sampling frequency from the console and updates the display.
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Working with Sessions
All of your console’s mix settings in PM5D Editor, including Scene and library data, are called Sessions. The following table describes how to handle Sessions.
Creating a new Session
Opening a previously saved Session
Saving the current Session
Saving the current Session with a new name

Choose [New Session] from the [File] menu.
Choose [Open Session] from the [File] menu.
Choose [Save Session] from the [File] menu.
Choose [Save Session As...] from the [File] menu.

When you save a session in the window of an editor, the settings of only that editor will be saved in a file. Session files
saved by PM5D Editor have a filename extension of “.YSE”. Files in which only the PM5D console data is saved (filename extension “.PM5”) can also be handled, allowing you to use a memory card to exchange data with the PM5D
console.
If you save a Session in the Studio Manager window, all selected Editor settings are saved in a file with a file extension
of “.YSM.”

Window operations
You can select and open each window from the [Windows] menu. For the INPUT CH window and Effect Editor window, use the sub-menu to select the channels or
library you want to see.

In the Library window or Scene window, click the tabs
located at the top of the window to switch between
pages.

4

PM5D Editor Owner’s Manual

Undo/Redo Function
In PM5D Editor, you can cancel the latest operation (Undo) and also cancel the cancellation of the latest operation
(Redo). If you perform an Undo operation twice in a row, you can cancel the two most-recent operations. If you perform an Undo operation three times in a row, you can cancel the three most-recent operations. In this way, you can
cancel multiple recent operations. The following table describes how to use the Undo/Redo function.
Undo
Redo

Choose [Undo] from the [Edit] menu.
Choose [Redo] from the [Edit] menu.

Please note, however, that after you perform one of the following operations, you cannot successfully undo or redo
any previous operation:
• Operations on the PM5D console
• Quitting Studio Manager
• Changing the surround mode or pair mode
• Synchronizing with the PM5D console
• Session operations
• The GEQ [EQ FLAT] button
• Moving the fader positions by changing the GEQ variable width
NOTE

You cannot Undo or Redo the following operations:
• Edits in the Setup window
• Synchronization
• Opening and closing the windows
• Resizing the windows

NOTE

In the Library window, you can Undo or Redo only the most recent operation. You cannot cancel the preceding operations.

Other Functions
❏ Resetting to the default value (Ctrl ( ) + click)
Move the cursor to a control or a parameter value, then hold down the <Ctrl> key ( ) and click the mouse button to reset the value to the default (e.g., to reset an Input Channel fader to – ∞, or reset a pan setting to Center).

❏ Ctrl ( ) +Shift+Click
Move the cursor to a fader or AUX Send control, then hold down the <Ctrl> key ( ) and <Shift> key and click
the mouse button to reset the value to the nominal level.
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INPUT CH window

This window displays the mix parameters of input channels 1–24 or 25–48. The window shows either the channel 1–
24 layer or the channel 25–48 layer. To open the other layer’s window, choose the [Windows] menu command
[INPUT CH] and choose “CH1-24” or “CH25-48.”
You can use the [View] menu to choose the parameters that will be displayed in the window.

1
2

3

A Input patch
Here you can select an input source to assign to the input channel, from the following
choices.
NONE
AD1–AD48
AD1L–AD4R
SLOT1-1, SLOT1-2...SLOT4-15, SLOT4-16
FXOUT1L, FXOUT1R...FXOUT8R,
FXOUT8L
2TR D1L, 2TR D1R...2TR D3L, 2TR D3R
2TR A1L, 2TR A1R...2TR A3L, 2TR A3R

No assignment
INPUT jacks 1–48
L/R channels of ST IN jacks 1–4
Input channels of an I/O card installed in slots
1–4
L/R outputs of internal effects 1–8
L/R channels of 2TR IN DIGITAL jacks 1–3
L/R channels of 2TR IN ANALOG jacks 1/2

B +48V
Switches on/off the phantom power (+48V) of the internal head amp (PM5D-RH
model only) or of the external head amp (AD8HR, AD824) patched to the input channel.

C HA GAIN
Drag the knob in the screen to adjust the gain of the internal head amp (PM5D-RH
model only) or of the external head amp (AD8HR, AD824) patched to the input channel.
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4
5
6
7
8
9
J

D HPF (High Pass Filter)
Switches the high pass filter on/off. You can drag the numeric value up or down to edit
the cutoff frequency.

E Ø (Phase)
Inverts the phase of the signal after AD conversion.

F INSERT
Enables/disables the insert-out that is patched in the PM5D’s INSERT PATCH screen
(INPUT PATCH function).

G DIRECT
Enables/disables the direct output that is patched in the PM5D’s DIRECT OUT PATCH
screen (INPUT PATCH function).

K
L

H GATE
Turns the gate on/off. The indicator immediately below the button
shows the gate’s on/off setting
and the open/closed status.

Gate= closed
(red)

Gate= open
(green)

Gate= off

I COMP (Compressor)
Switches the compressor on/off. When the compressor is on, the GR meter immediately
below the button shows the amount of gain reduction.

M

J EQ (Equalizer)
Switches the EQ on/off. The graph immediately below the button shows the approximate response of the EQ. You can drag within the graph to edit the response of the EQ.
To reset the EQ to flat response, hold down the <Ctrl> key (
key) of your computer
keyboard and click the graph.

K DELAY
Switches the delay on/off. You can also edit the delay time by dragging the numeric
value located immediately below the button up or down

L Channel number
N
O
P

Indicates the input channel number corresponding to this module. You can doubleclick this number to open the Selected Channel window for this channel.

M MIX SEND
The bar graphs in this area indicate the send levels of
the signals sent from the input channel to VARI-type
MIX buses. You can also adjust the send levels by dragging a bar graph to left or right.
The bar graph display will change according to the
send position (pre/post) and on/off status of the signal
sent from the input channel to the MIX buses.
NOTE

Pre/on (green)
Pre/off (green)
Post/on (yellow)
Post/off (yellow)

For FIXED-type MIX buses, the bar graph is fixed at nominal level (0 dB),
and only the on/off status is shown.

N PAN
Sets the panning of the signal sent from the input channel to the STEREO bus.

O SELECT
Selects input channel for which you want to perform operations. This is linked with the
INPUT channel strip [SEL] keys on the PM5D panel. However it will no longer be
linked if you turn Channel Select off (➥ p.2) in the System Setup window.

P CH ON (Channel on) button
Switches the input channel on/off. This is linked with the INPUT channel strip CH
[ON] keys on the PM5D panel.
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Q

R

Q Channel name
This is a text box that displays the channel name. You can also edit the channel name in
this text box.
Note that while the channel number (L) will not change even if you switch the pair
mode, the channel name display will change according to the pair mode.
For example if the CH1-24 layer is displayed, switching from Horizontal Pair mode to
Vertical Pair mode will change the channel name display from channels 1, 2, 3 ... 24, 25
to channels 1, 3, 5...45, 47.

R Fader
Adjusts the input level of the input channel. This is linked with the INPUT channel
strip faders on the PM5D panel.
The current fader value is shown in the numeric box immediately below the fader. The
level meter at the right of the fader shows the level of the input signal.

S

The numbers and
alphabetical letters at
the right of the fader
indicate the DCA
group and mute
groups to which that
channel belongs, and
show the Recall Safe
and Mute Safe status of
the channel.

The numbers of DCA groups to which this
channel belongs are shown in yellow.

The numbers of mute groups to which this
channel belongs are shown in red.

If this channel is set to Recall Safe, the R
character is shown in orange.
If this channel is set to Mute Safe, the M character is shown in red.

S CUE
This button cue-monitors the signal of the input channel. This is linked with the
INPUT channel strip [CUE] keys on the PM5D panel.
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ST IN window

In this window you can view and edit the mix parameters of ST IN channels 1–4. You can use the [View] menu to
choose the parameters that will be displayed in the window.

1
2

A Input patch
Selects the input source that will be assigned to the ST IN channel. The input sources
that can be assigned are the same as for an input channel (➥ p.6).

B +48V
3
4
5
6
7

Switches on/off the phantom power (+48V) of the internal head amp (PM5D-RH
model only) or of the external head amp (AD824, AD8HR) patched to the ST IN channel.

C HA GAIN
Drag the knob in the screen to adjust the gain of the internal head amp (PM5D-RH
model only) or of the external head amp (AD824, AD8HR) patched to the ST IN channel.

D HPF (High Pass Filter)
Switches the high pass filter on/off. You can drag the numeric value up or down to edit
the cutoff frequency.

E Ø (Phase)
Inverts the phase of the signal after AD conversion.

F INSERT
Enables/disables the insert-out that is patched in the PM5D’s INSERT PATCH screen
(INPUT PATCH function). (The L/R settings are linked.)

G DIRECT
Enables/disables the direct out that is patched in the PM5D’s DIRECT OUT PATCH
screen (INPUT PATCH function). (The L/R settings are linked.)
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8
9
J

H GATE
Turns the gate on/off. The indicator immediately below the button shows the gate’s on/
off setting and the open/closed status (➥ p.7).

I COMP (Compressor)
Switches the compressor on/off. When the compressor is on, the GR meter immediately
below the button shows the amount of gain reduction.

K
L

J EQ (Equalizer)
Switches the EQ on/off (the L/R settings are linked). The graph immediately below the
button shows the approximate response of the EQ. You can drag the graph to edit the
response of the EQ, or hold down the <Ctrl> key (
key) of your computer keyboard
and click the graph to reset it to a flat response.

K DELAY
Switches the delay on/off. You can also edit the delay time by dragging the numeric
value located immediately below the button up or down

L Channel number
M

This is the number of the ST IN channel for this module. You can double-click this
number to open the Selected Channel window for this channel.

M MIX SEND
The send levels of the signals sent from the ST IN channel to the VARI-type MIX buses
are shown as bar graphs (the L/R settings are linked). You can also adjust the send levels
by dragging a bar graph to left or right.
The bar graph display will change according to the send position (pre/post) and on/off
status of the signal sent from the ST IN channel to the MIX buses (➥ p.7).

N PAN
N
O
P
Q

Specifies the panning of the signal sent from the ST IN channel to the STEREO bus.
(You can set L and R separately.)

O SELECT
Selects the ST IN channel for which you want to perform operations. (L and R can be
selected separately.) This is linked with the ST IN channel strip [SEL] keys on the
PM5D panel. However it will no longer be linked if you turn Channel Select off (➥ p.2)
in the System Setup window.

P CH ON (Channel on) button
R

Switches the ST IN channel on/off (the L/R settings are linked). This is linked with the
ST IN channel strip CH [ON] keys on the PM5D panel.

Q Channel name
This is a text box that displays the channel name. You can also edit the channel name in
this text box.

R Fader

S

Adjusts the input level of the ST IN channel. This is linked with the faders of the ST IN
channel strip on the PM5D panel.
The numbers and alphabetical letters at the right of the fader indicate the DCA group
and mute groups to which that channel belongs, and show the Recall Safe and Mute
Safe status of the channel (➥ p.8).

S CUE
This button cue-monitors the signal of the ST IN channel (L/R are linked). This is
linked with the ST IN channel strip [CUE] keys on the PM5D panel.
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FX RTN window

In this window you can view and edit the mix parameters of FX RTN channels 1–4. You can use the [View] menu to
choose the parameters that will be displayed in the window.

1
2

A Input patch
Selects the input source that will be assigned to the FX RTN channel. The input sources
that can be assigned are the same as for an input channel (➥ p.6).

B +48V
3
4
5

Switches on/off the phantom power (+48V) of the internal head amp (PM5D-RH
model only) or of the external head amp (AD8HR, AD824) patched to the FX RTN
channel.

C HA GAIN
Drag the knob in the screen to adjust the gain of the internal head amp (PM5D-RH
model only) or of the external head amp (AD8HR, AD824) patched to the FX RTN
channel.

D HPF (High Pass Filter)
Switches the high pass filter on/off. You can drag the numeric value up or down to edit
the cutoff frequency.

6

E Ø (Phase)
Inverts the phase of the signal after AD conversion.

F EQ (Equalizer)
Switches the EQ on/off (the L/R settings are linked). The graph immediately below the
button shows the approximate response of the EQ. You can drag the graph to edit the
response of the EQ, or hold down the <Ctrl> key (
key) of your computer keyboard
and click the graph to reset it to a flat response.
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7

G Channel number
This is the number of the FX RTN channel for this module. You can double-click this
number to open the Selected Channel window for this channel.

H MIX SEND

8

The send levels of the signals sent from the FX RTN channel to the VARI-type MIX
buses are shown as bar graphs (the L/R settings are linked). You can also adjust the send
levels by dragging a bar graph to left or right.
The bar graph display will change according to the send position (pre/post) and on/off
status of the signal sent from the FX RTN channel to the MIX buses (➥ p.7).

I PAN
Specifies the panning of the signal sent from the FX RTN channel to the STEREO bus.
(You can set L and R separately.)

J SELECT
Selects the FX RTN channel for which you want to perform operations. (L and R can be
selected separately.) This is linked with the FX RTN channel strip [SEL] keys on the
PM5D panel. However it will no longer be linked if you turn Channel Select off (➥ p.2)
in the System Setup window.

9

K CH ON (Channel on) button

J
K
L

L Channel name

Switches the FX RTN channel on/off. (The L/R settings are linked.) This is linked with
the FX RTN channel strip CH [ON] keys on the PM5D panel.
This is a text box that displays the channel name. You can also edit the channel name in
this text box.

M Fader
Adjusts the input level of the FX RTN channel. This is linked with the faders of the FX
RTN channel strip on the PM5D panel.
The numbers and alphabetical letters at the right of the fader indicate the DCA group
and mute groups to which that channel belongs, and show the Recall Safe and Mute
Safe status of the channel (➥ p.8).

N CUE
This button cue-monitors the signal of the FX RTN channel (L/R are linked). This is
linked with the FX RTN channel strip [CUE] keys on the PM5D panel.

M
N
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MIX window

In this window you can view and edit the parameters of MIX channels 1–24. You can use the [View] menu to choose
the parameters that will be displayed in the window.

1

2
3
4
5

A EQ (Equalizer)
Switches the EQ on/off. The graph immediately below the button shows the approximate response of the EQ. You can drag the graph to edit the response of the EQ, or hold
down the <Ctrl> key (
key) of your computer keyboard and click the graph to reset
it to a flat response.

B COMP (Compressor)
Switches the compressor on/off. When the compressor is on, the GR meter immediately
below the button shows the amount of gain reduction.

C INSERT
Enables/disables the insert-out that is patched in the PM5D’s INSERT PATCH screen
(OUTPUT PATCH function).

D DELAY
Switches the delay on/off. You can also edit the delay time by dragging the numeric
value located immediately below the button up or down

E Channel number
Indicates the number of the MIX channel corresponding to this module. You can double-click this number to open the Selected Channel window for this channel.
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F MTRX (Send level to MATRIX buses)
6

7
8
9
J
K

These bar graphs indicate the send levels of the signals
sent from the MIX channel to each MATRIX bus. You
can also adjust the send levels by dragging a bar graph
to left or right.
The bar graph display will change as follows according
to the send position (pre/post) and on/off status of the
signal sent from the MIX channel to the MATRIX
buses.

Pre/on (green)
Pre/off (green)
Post/on (yellow)
Post/off (yellow)

G TO ST (To STEREO)
This is an on/off switch for the signal sent from the MIX channel to the STEREO bus.

H PAN
Sets the panning of the signal sent from the MIX channel to the STEREO bus.

I VARI/FIXED

L

Indicates the type (VARI or FIXED) of the currently selected MIX bus. (This parameter
is for display only. You cannot switch between VARI and FIXED from within PM5D
Editor.)
If surround mode is enabled, MIX buses that are assigned as surround buses are displayed with the name of the surround channel (L, R, Ls, Rs ...), and the other MIX
buses are displayed as “FIXED.”

J SELECT
Selects the MIX channel for which you want to make settings. This is linked with the
MIX [SEL] keys in the MIX section of the PM5D panel. However it will no longer be
linked if you turn Channel Select off (➥ p.2) in the System Setup window.

K ON
Switches the MIX channel on/off.

M

L Fader
Adjusts the output level of the MIX channel. The current fader value is shown in the
numeric box immediately below the fader. The level meter at the right of the fader
shows the output level of the signal.
The numbers and alphabetical letters at the right of the fader indicate the DCA group
and mute groups to which that channel belongs, and show the Recall Safe and Mute
Safe status of the channel. (For the significance of the numbers and alphabetical letters,
see ➥ p.8).

M CUE
This button cue-monitors the signal of the MIX channel. This is linked with the MIX
[CUE] keys in the MIX section of the PM5D panel.
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MATRIX window

In this window you can view and edit the parameters of MATRIX channels 1–8. You can use the [View] menu to
choose the parameters that will be displayed in the window.
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A MIX (Send levels from the MIX channels to the MATRIX bus)
Here you can view and edit the send levels of the signals sent from each MIX channel to
the MATRIX bus. The method of operation and the meaning of the display are the same
as for (6) MTRX in the MIX window (➥ p.14).

B STEREO (Send levels from the STEREO channels to the MATRIX
bus)
1

Here you can view and edit the send levels of the signals sent from the STEREO A/B
channels to the MATRIX bus. The method of operation and the meaning of the display
are the same as for (6) MTRX in the MIX window (➥ p.14).

C Channel number
Indicates the number of the MATRIX channel corresponding to this module. You can
double-click this number to open the Selected Channel window for this channel.

D EQ (Equalizer)

2
3
4

Switches the EQ on/off. The graph immediately below the button shows the approximate response of the EQ. You can drag the graph to edit the response of the EQ, or hold
down the <Ctrl> key (
key) of your computer keyboard and click the graph to reset
it to a flat response.

E COMP (Compressor)
Switches the compressor on/off. When the compressor is on, the GR meter immediately
below the button shows the amount of gain reduction.

F INSERT
5
6
7
8
9

Enables/disables the insert-out that is patched in the PM5D’s INSERT PATCH screen
(OUTPUT PATCH function).

G DELAY
Switches the delay on/off. You can also edit the delay time by dragging the numeric
value located immediately below the button up or down

H SELECT
Selects the MATRIX channel for which you want to make settings. This is linked with
the MATRIX [SEL] keys in the MATRIX section of the PM5D panel. However it will no
longer be linked if you turn Channel Select off (➥ p.2) in the System Setup window.

I ON
J

This switches the MATRIX channel on/off. This is linked with the MATRIX [ON] keys
in the MATRIX section of the PM5D panel.

J Fader
This adjusts the output level of the MATRIX channel. The current fader value is shown
in the numeric box immediately below the fader. The level meter at the right of the
fader shows the output level of the signal.
The numbers and alphabetical letters at the right of the fader indicate the DCA group
and mute groups to which that channel belongs, and show the Recall Safe and Mute
Safe status of the channel. (For the significance of the numbers and alphabetical letters,
see ➥ p.8).

K

K CUE
This button cue-monitors the signal of the MATRIX channel. This is linked with the
MATRIX [CUE] keys in the MATRIX section of the PM5D panel.

16

PM5D Editor Owner’s Manual

STEREO window

In this window you can view and edit the parameters of the STEREO A/B channels. You can use the [View] menu to
choose the parameters that will be displayed in the window.
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1

2
3
4
5

A EQ (Equalizer)
Switches the EQ on/off (the L/R settings are linked). The graph immediately below the
button shows the approximate response of the EQ. You can drag the graph to edit the
response of the EQ, or hold down the <Ctrl> key (
key) of your computer keyboard
and click the graph to reset it to a flat response.

B COMP (Compressor)
Switches the compressor on/off (the L/R settings are linked). When the compressor is
on, the GR meter immediately below the button shows the amount of gain reduction.

C INSERT
Enables/disables the insert-out that is patched in the PM5D’s INSERT PATCH screen
(OUTPUT PATCH function). (The L/R settings are linked.)

6

D DELAY
Switches the delay on/off. (L/R settings can be made independently.) You can also edit
the delay time by dragging the numeric value located immediately below the button up
or down

7
8
9

E Channel number
This is the channel number (STEREO A or B) of this module. You can double-click this
number to open the Selected Channel window for this channel.

F MTRX (Send level to MATRIX buses)
Here you can view and edit the send levels of the signals sent from the STEREO A/B
channel to each MATRIX bus. The method of operation and the meaning of the display
are the same as for (6) MTRX in the MIX window (➥ p.14).

J

G BALANCE
Adjusts the left/right balance of the STEREO A/B channel.

H SELECT
Selects the STEREO A/B channel for which you want to make settings. (You can specify
L and R independently.) This is linked with the STEREO [SEL] key in the STEREO A/B
channel strip of the PM5D panel. However it will no longer be linked if you turn Channel Select off (➥ p.2) in the System Setup window.

I ON
K

This switches the STEREO A/B channel on/off. This is linked with the STEREO [ON]
key in the STEREO A/B channel strip of the PM5D panel.

J Fader
Adjusts the output level of the STEREO A/B channel. This is linked with the STEREO
fader in the STEREO A/B channel strip of the PM5D panel.
The current fader value is shown in the numeric box immediately below the fader. The
level meter at the right of the fader shows the output level of the signal.
The numbers and alphabetical letters at the right of the fader indicate the DCA group
and mute groups to which that channel belongs, and show the Recall Safe and Mute
Safe status of the channel. (For the significance of the numbers and alphabetical letters,
see ➥ p.8).

K CUE
This button cue-monitors the signal of the STEREO A/B channel. This is linked with
the STEREO [CUE] key in the STEREO A/B channel strip of the PM5D panel.
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DCA window

In this window you can view and edit the parameters of DCA groups 1–8.

1
2
3

A DCA number
This is the number of the DCA group.

B MUTE
This switches DCA group muting on/off. This is linked with the DCA [MUTE] keys in
the DCA strip section of the PM5D panel.

C DCA group name
4

This is a text box that displays the DCA group name. You can also edit the DCA group
name in this text box.

D DCA fader

5

This fader adjusts the level of the DCA group. This is linked with the DCA faders in the
DCA strip section of the PM5D panel.
The current fader value is shown in the numeric box immediately below the fader.
When you hold down the <Ctrl> key (
key) and <Shift> key of your computer keyboard and click a fader, the corresponding fader will be set to nominal level (0 dB).
When the fader is at nominal level, the N character at the right of the fader is displayed
in green.
If a DCA group is set to Recall Safe, the R character at the lower right of the fader is displayed in orange.

E CUE
This button cue-monitors the DCA group. This is linked with the DCA [CUE] keys in
the DCA channel strip of the PM5D panel.
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Selected Channel window
Here you can set the parameters of the currently selected input channel (input channels 1–48, ST IN channels 1–4,
FX RTN channels 1–4) or output channel (MIX channels 1–24, MATRIX channels 1–8, STEREO A/B channels).
The type of parameters that can be edited in this window will depend on the type of the currently selected channel.
The parameters of the Selected Channel window are explained below, in the order of input channels (input channels
1–48, ST IN channels 1–4, FX RTN channels 1–4), MIX channels, MATRIX channels, and STEREO A/B channels.

If an input channel is selected

NOTE

Unless otherwise specified, the parameters explained below are common to input channels 1–48, ST IN
channels 1–4, and FX RTN channels 1–4.

❏ CHANNEL SELECT (Channel selection)

1

2

3

4

A SELECT (Channel selection)
Indicates the number and name of the channel you are editing. To switch channels, use the SELECT button or the
/ buttons at left and right. You can also edit the channel name in the text box.

B PAIR
Indicates the pair status of the selected channel. You can click the heart symbol to enable/disable pairing.

C INPUT PATCH

Selects the input source assigned to the input channel (for the selectable input sources, ➥ p.6).

D LIBRARY
Accesses the INPUT CH page of the LIBRARY window.
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❏ HA GAIN/Ø/HPF (HA gain/phase/high-pass filter)
1

2

3

A HA GAIN
Adjusts the gain of the internal head amp (PM5D-RH model only) or of the external head amp (AD8HR, AD824)
patched to the input channel. The current setting is shown in the numerical box above the knob. You can also use
the +48V button to switch phantom power on/off.

B Ø (Phase)
Inverts the phase of the signal after AD conversion.

C HPF (High Pass Filter)
Use the HPF button at the right to switch the high-pass filter on/off. You can use the knob at left to adjust the cutoff frequency. The current setting is shown in the numerical box above the knob.

❏ GATE (except for FX RTN channels)
1

2

4
3
6
5
8
7

9
J

L M

K

N

A Gate graph
Indicates the approximate response for the gate of the currently selected channel.

B GR meter
This meter indicates the amount of gain reduction.

C TYPE
Indicates the type of the currently selected gate.

D THRESHOLD (Threshold level)
Specifies the level at which the gate will open and close. The gate will open when the key-in signal exceeds this
level, and will close when the signal falls below this level.

E RANGE
Specifies the amount by which the signal is attenuated while the gate is closed.
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F DECAY (Decay time)
Specifies the time over which the gate will close after the hold time has elapsed.

G ATTACK (Attack time)
Specifies the time from when the key-in signal exceeds the threshold level until the gate opens.

H HOLD (Hold time)
Specifies the time that the gate will remain open after the key-in signal falls below the threshold.

I ON (On/off)
This button switches the gate on/off.

J LIBRARY
This button accesses the gate library. Clicking this button will open the GATE page of the LIBRARY window.

K LINK (Stereo link)
This button links the parameter settings and key-in signals of adjacent odd-numbered/even-numbered input
channels or the L/R sides of a ST IN channel, so that gating will operate in tandem for the two channels.

L KEY IN SOURCE
Select the desired key-in signal from the following choices.
SELF PRE EQ
SELF POST EQ
CH 1–48 POST EQ
ST IN 1L/1R – 4L/4R POST EQ
MIX 21–24 OUT

The pre-EQ signal of the currently selected input channel
The post-EQ signal of the currently selected input channel
The post-EQ signal of the corresponding input channel (however, you can only choose
channels belonging to the same group, within the seven groups CH1–8, CH9–16,
CH17–24, CH25–32, CH33–40, CH41–48, and ST IN 1L/1R–4L/4R).
The output signal of the corresponding MIX channel immediately before the output
attenuation

M CUE
This button cue-monitors the currently selected key-in signal.

N KEY IN FILTER
Select the type of filter applied to the selected key-in signal; HPF (high pass filter), BPF (band pass filter), or LPF
(low pass filter). The ON/OFF button located immediately below switches the filter on/off.
If you’ve selected BPF, use the two knobs at right to adjust the band pass frequency and Q. If you’ve selected HPF
or LPF, use the knob at left to adjust the cutoff frequency.
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❏ COMPRESSOR
1

2

4
3
6
5
9

K
J

8
7

M

L

N

A Compressor graph
Indicates the approximate response for the compressor of the currently selected channel.

B GR meter
This meter indicates the amount of gain reduction produced by the compressor.

C TYPE
Indicates the type of the currently selected compressor.

D THRESHOLD (Threshold level)
Specifies the threshold level at which the compressor will operate. The input signal will start being compressed
when the key-in signal exceeds this level; compression will be removed when the signal falls below this level.

E RATIO
Specifies the ratio at which the input signal will be compressed when the key-in signal exceeds the threshold.

F KNEE
Specifies the sharpness at which the output level will change. You can select from HARD or 1–5.

G ATTACK (Attack time)
Specifies the time from when the key-in signal exceeds the threshold level until the signal starts being compressed.

H RELEASE (Release time)
Specifies the time from when the key-in signal falls below the threshold level until compression is removed.

I GAIN
Adjusts the gain of the signal after it has passed through the compressor.

J ON (On/off)
This button switches the compressor on/off.

K LIBRARY
This button accesses the compressor library. Clicking this button will open the COMP page of the LIBRARY window.

L LINK (Stereo link)
This button links the parameter settings and key-in signals of adjacent odd-numbered/even-numbered input
channels or the L/R sides of a ST IN channel, so that compression will operate in tandem for the two channels.

M COMP LINK GROUP (Compressor link group)
Selects the compressor link group (1–8) to which that channel belongs.

N KEY IN
Selects the signal that will be used as the key-in signal. The types of signal that can be selected are the same as for
the gate key-in signal (➥ p.22).
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❏ INSERT (except for FX RTN channels)

1

2

3

4

A ON (On/off)
Enables/disables insert-in/out.

B OUT (Insert out)
Here you can select the output port that will be assigned to insert-out, from the following choices.
NONE
SLOT1-1, SLOT1-2...SLOT4-15, SLOT4-16
FXIN1L, FXIN1R...FXIN8R, FXIN8L
GEQIN 1–12
2TR D1L, 2TR D1R...2TR D3L, 2TR D3R

No assignment
Output channels of an I/O card installed in slots 1–4
L/R inputs of internal effects 1–8
Inputs of GEQ modules 1–12
L/R channels of 2TR OUT DIGITAL jacks 1–3

C IN (Insert in)
Here you can select the input port that will be assigned to insert-in, from the following choices.
NONE

No assignment

AD1–AD48
SLOT1-1, SLOT1-2...SLOT4-15, SLOT4-16
FXOUT1L, FXOUT1R...FXOUT8R, FXOUT8L
GEQOUT 1–12
2TR D1L, 2TR D1R...2TR D3L, 2TR D3R
2TR A1L, 2TR A1R, 2TR A2L, 2TR A2R

INPUT jacks 1–48
Input channels of an I/O card installed in slots 1–4
L/R outputs of internal effects 1–8
Outputs of GEQ modules 1–12
L/R channels of 2TR IN DIGITAL jacks 1–3
L/R channels of 2TR IN ANALOG jacks 1/2

D POINT (Insert point)
Selects the position at which insert-in/out will be patched. Choose from Pre EQ, Post EQ, Pre Delay, or Post
Fader.
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❏ EQUALIZER
2
1

8
7

6
3

4

5
J
9
K
M
L
A EQ graph
Indicates the approximate response for the EQ of the currently selected channel.

B FLAT
If you click this button, the gain of all bands will be reset to 0.0 dB.

CQ
D F (Frequency)
E GAIN
These knobs adjust the Q, center frequency, and boost/cut amount for the four bands LOW, LO-MID, HI-MID,
and HIGH.

F

(LOW shelving)
If this button is on, the LOW EQ will be switched to a shelving type (the Q knob of the LOW EQ will disappear).

G

(HIGH shelving)
If this button is on, the HIGH EQ will be switched to a shelving type (the Q knob of the HIGH EQ will disappear).

H LPF (Low Pass Filter)
If this button is on, the HIGH EQ will function as a low pass filter. The Q knob of the HIGH EQ will disappear,
and the GAIN knob will act as the low pass filter on/off switch.

I ON (On/off)
Switches the EQ on/off.

J LIBRARY
Accesses the INPUT EQ page of the LIBRARY window.

K TYPE I/TYPE II (EQ type)
Selects either TYPE I (an algorithm equivalent to the EQ in the earlier 02R series) or TYPE II (a newly developed
algorithm) as the EQ type.

L EQ LINK GROUP
Selects the EQ link group (1–8) to which that channel belongs.
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M ATT (Attenuation)
Adjusts the amount of attenuation/gain following AD conversion.

❏ DELAY
A TIME (Delay time)
Adjusts the delay time for each channel.

B ON (On/off)
Switches the delay on/off. The current value (ms units) is shown in the box at the right.

1

2

❏ M/S DECODE (except for FX RTN channels)
A S-GAIN
This knob sets the proportionate level of the S mic relative to the level of the M
mic. The current value (dB units) is shown in the box at the right.

B ON (On/off)
1

This button switches M/S decoding on/off for two adjacent odd-numbered/evennumbered input channels (or ST IN channel L/R).

2

❏ DCA GROUP / MUTE GROUP / SAFE
1

2

3

A DCA GROUP
Selects the DCA group (1–8) to which that channel belongs.

B MUTE GROUP
Selects the mute group (1–8) to which that channel belongs.

C RECALL SAFE / MUTE SAFE
These enable/disable Recall Safe and Mute Safe for the channel.
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❏ Pan / Fader
1
2
3
4

5
6
7

A DIRECT (except for FX RTN channels)
Turns the direct output on/off.

B Direct Output Port (except for FX RTN channels)
Choose the port from which this input channel 1–48 or this ST IN channel 1–4 will be
directly output.
NONE
SLOT1-1, SLOT1-2...SLOT4-16
2TR D1L, 2TR D1R...2TR D3R

No assignment
Output channels of an I/O card installed in slots 1–4
L/R channels of 2TR OUT DIGITAL jacks 1–3

C FOLLOW PAN
Use the following two buttons to specify how the signal sent from the input channel to
the MIX bus will be affected by the TO ST PAN knob (5).

• VARI button
If this button is on, the PAN knob displayed in the CH to MIX area will be linked
with the TO ST PAN knob if VARI-type MIX buses are paired.

8

• FIXED button
If this button is on, the signal from after the TO ST PAN (5) knob will be sent to
FIXED-type MIX buses.

D TO ST (To stereo)
9

This is an on/off switch for the signal sent from the input channel to the STEREO bus.
This is linked with the [TO STEREO] key in the SELECTED CHANNEL section of the
panel.

E TO ST PAN (To stereo pan)
Adjusts the panning of the signal sent from the input channel to the STEREO bus. This
is linked with the encoder of each channel if PAN is selected as the encoder mode, and
with the [PAN] encoder of the SELECTED CHANNEL section.

F LCR
J

Turns LCR mode on/off for each channel. If this is turned on for a channel, you can use
the TO ST PAN (5) knob to simultaneously control the level of the signal sent to the
STEREO bus L/R channels and CENTER channel.

G CSR (Center Side Ratio)
This adjusts the level ratio (0–100%) of the CENTER channel relative to the STEREO
bus L/R channels. To change the value, drag upward or downward inside the numerical
box.

H ON
Switches the input channel on/off. This is linked with the INPUT channel strip CH
[ON] keys on the PM5D panel.

I Fader
Adjusts the input level of the input channel. This is linked with the INPUT channel
strip faders on the PM5D panel. The current value is shown in the numerical box
immediately below.

J CUE
This button cue-monitors the signal of the input channel. This is linked with the
INPUT channel strip [CUE] keys on the PM5D panel.
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❏ CH to MIX (Channel to mix)
2
1
3
4

5
A MIX send level
This adjusts the send level of the signal sent from the input channel to VARI-type MIX buses. The current value is
shown in the numerical box immediately above.

B Pair
This indicates the pairing status of adjacent odd-numbered/even-numbered MIX channels. You can click the
heart symbol to enable/disable pairing.

C ON (MIX send on/off)
This is an on/off switch for the signal sent from the input channel to the MIX bus.

D PRE (Pre/Post)
This selects PRE or POST as the point from which the signal is sent from the input channel to the MIX bus.

E CH to MIX PRE POINT
This selects PRE EQ or PRE FADER as the point from which the signal is sent when the PRE button ( 4) is set to
PRE.
NOTE

If the PRE button is set to POST, you can select either POST ON or POST TO ST as the signal send location individually for each MIX bus (➥ p.33).
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If a MIX channel is selected

❏ CHANNEL SELECT (Channel selection)
Except for the fact that your editing applies to a MIX channel, this is the same as for an input channel (➥ p.20).

❏ COMPRESSOR
Except for the fact that the COMP LINK GROUP is A–F, and that the types of signal that can be selected for keyin are different, this is the same as for the compressor of an input channel (➥ p.23).

❏ INSERT
Except for the fact that the insert points that can be selected are different, this is the same as for the insert settings
of an input channel (➥ p.24).
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❏ EQUALIZER
2
1

9
8

7
6
3

4

5
K
J
L

M

N

A EQ graph
Indicates the approximate response for the EQ of the currently selected channel.

B FLAT
If you click this button, the gain of all bands will be reset to 0.00 dB.

CQ
D F (Frequency)
E GAIN
These knobs adjust the Q, center frequency, and boost/cut amount for each band.

F

(LOW shelving)
If this button is on, the LOW EQ will be switched to a shelving type (the Q knob of the LOW EQ will disappear).

G HPF (High Pass Filter)
If this button is on, the LOW EQ will function as a high pass filter EQ. The Q knob of the LOW EQ will disappear,
and the GAIN knob will act as the high pass filter on/off switch.

H

(HIGH shelving)
If this button is on, the HIGH EQ will be switched to a shelving type (the Q knob of the HIGH EQ will disappear).

I LPF (Low Pass Filter)
If this button is on, the HIGH EQ will function as a low pass filter. The Q knob of the HIGH EQ will disappear,
and the GAIN knob will act as the low pass filter on/off switch.

J ON (On/off)
Switches the EQ on/off.

K LIBRARY
Accesses the OUTPUT EQ page of the LIBRARY window.
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L TYPE I/TYPE II (EQ type)
Selects either TYPE I (an algorithm equivalent to the EQ in the earlier 02R series) or TYPE II (a newly developed
algorithm) as the EQ type.

M EQ LINK GROUP
Selects the EQ link group (A–F) to which that channel belongs.

N UPPER/LOWER
Switches the four bands affected by controls 3–9 between LOWER (1 LOW–4 HIGH) and UPPER (5 LOW–8
HIGH).

❏ DELAY
This is the same as for the delay settings of an input channel (➥ p.26).

❏ DCA GROUP / MUTE GROUP / SAFE
1

2

3

A DCA GROUP
Selects the DCA group (7/8) to which the MIX channel belongs.

B MUTE GROUP
Selects the mute group (1–8) to which the MIX channel belongs.

C RECALL SAFE / MUTE SAFE
These enable/disable Recall Safe and Mute Safe for the MIX channel.

31

PM5D Editor Owner’s Manual

❏ Pan / Fader
A TO ST (To stereo)

1

This is an on/off switch for the signal sent from the MIX channel to the STEREO bus.
The PRE button located below selects PRE (immediately before the MIX [ON] key) or
POST (immediately after the MIX [ON] key) as the point from which the signal is sent
from the MIX channel to the STEREO bus.

B TO ST PAN (To stereo pan)
Sets the panning of the signal sent from the MIX channel to the STEREO bus.

2
3
4

C LCR
Turns LCR mode on/off for each channel. If this is turned on for a channel, you can use
the TO ST PAN (2) knob to simultaneously control the level of the signal sent to the
STEREO bus L/R channels and CENTER channel.

D CSR (Center Side Ratio)
5
6

This adjusts the level ratio (0–100%) of the CENTER channel relative to the STEREO
bus L/R channels. To change the value, drag upward or downward inside the numerical
box.

E BALANCE
This adjusts the left/right output balance of paired channels. This is not shown if pairing is not specified.

F ON
7

Switches the MIX channel on/off. This is linked with the MIX [ON] keys in the MIX
section of the PM5D panel.

G Fader
Adjusts the output level of the MIX channel. This is linked with the MIX encoders on
the PM5D panel (if the [MIX MASTER] key is on). The current value is shown in the
numerical box immediately below.

H CUE
This button cue-monitors the signal of the MIX channel. This is linked with the MIX
[CUE] keys in the MIX section of the PM5D panel.

8
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❏ MIX to MATRIX
2
1
3

4

5
A MATRIX send level
This adjusts the send level of the signal sent from the MIX channel to the MATRIX buses.

B Pair
This indicates the pairing status of adjacent odd-numbered/even-numbered MATRIX channels. You can click the
heart symbol to enable/disable pairing.

C ON (MATRIX send on/off)
This is an on/off switch for the signal sent from the MIX channel to the MATRIX bus.

D POINT (Send point)
Selects the point from which the signal is sent from the MIX channel to the MATRIX bus. You can choose PRE
FADER (immediately before the fader), POST FADER (immediately after the fader), or POST ON (immediately
after the MIX [ON] key).

E CH to MIX POST POINT
Selects either POST ON or POST TO ST as the position from which the signal is sent from all input channels to
the currently selected MIX bus.
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If a MATRIX channel is selected

❏ CHANNEL SELECT (Channel selection)
Except for the fact that your editing applies to a MATRIX channel, this is the same as for an input channel
(➥ p.20).

❏ COMPRESSOR
Except for the fact that the COMP LINK GROUP is A–F, and that the types of signal that can be selected for keyin are different, this is the same as for the compressor of an input channel (➥ p.23).

❏ INSERT
Except for the fact that the insert points that can be selected are different, this is the same as for the insert settings
of an input channel (➥ p.24).

❏ EQUALIZER
Except for the fact that there is no LOWER/UPPER button, and that the EQ LINK groups are G/H, this is the
same as for the equalizer of a MIX channel (➥ p.30).

❏ DELAY
This is the same as for the delay settings of an input channel (➥ p.26).

❏ DCA GROUP / MUTE GROUP / SAFE
These are the same as the DCA Group / Mute Group / Safe settings of a MIX channel (➥ p.31).
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❏ Pan / Fader
A BALANCE
1
2

This adjusts the left/right output balance of paired channels. This is not shown if pairing is not specified.

B ON
This switches the MATRIX channel on/off. This is linked with the MATRIX [ON] keys
in the MATRIX section of the PM5D panel.

C Fader
3

This adjusts the output level of the MATRIX channel. This is linked with the MATRIX
encoders in the MATRIX section of the PM5D panel. The current value is shown in the
numerical box immediately below.

D CUE
This button cue-monitors the signal of the MATRIX channel. This is linked with the
MATRIX [CUE] keys in the MATRIX section of the PM5D panel.

4

If a STEREO A/B channel is selected

❏ CHANNEL SELECT (Channel selection)
Except for the fact that your editing applies to a STEREO A/B channel, this is the same as the channel selection for
an input channel (➥ p.20).
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❏ COMPRESSOR
Except for the fact that the COMP LINK GROUP is A–F, and that the types of signal that can be selected for keyin are different, this is the same as for the compressor of an input channel (➥ p.23).

❏ INSERT
Except for the fact that the insert points that can be selected are different, this is the same as for the insert settings
of an input channel (➥ p.24).

❏ EQUALIZER
This is the same as the equalizer settings of a MIX channel (➥ p.30).

❏ DELAY
This is the same as for the delay settings of an input channel (➥ p.26).

❏ DCA GROUP / MUTE GROUP / SAFE
These are the same as the DCA Group / Mute Group / Safe settings of a MIX channel (➥ p.31).

❏ Pan / Fader
A BALANCE
Adjusts the left/right output balance of the STEREO A/B channel.

1
2

B ON
This switches the STEREO A/B channel on/off. This is linked with the STEREO [ON]
key in the STEREO A/B channel strip of the PM5D panel.

C Fader

3

Adjusts the output level of the STEREO A/B channel. This is linked with the STEREO
fader in the STEREO A/B channel strip of the PM5D panel. The current value is shown
in the numerical box immediately below.

D CUE
This button cue-monitors the signal of the STEREO A/B channel. This is linked with
the STEREO [CUE] key in the STEREO A/B channel strip of the PM5D panel.

4

36

PM5D Editor Owner’s Manual

❏ STEREO to MATRIX
2
1
3

4
A MATRIX send level
Here you can adjust the send levels of the signals sent from the STEREO A/B channels to the MATRIX bus.

B Pair
This indicates the pairing status of adjacent odd-numbered/even-numbered MATRIX channels. You can click the
heart symbol to enable/disable pairing.

C ON (MATRIX send on/off)
This is an on/off switch for the signal sent from the STEREO A/B channel to the MATRIX bus.

D POINT (Send point)
Selects the point from which the signal is sent from the STEREO A/B channel to the MATRIX bus. You can choose
PRE FADER (immediately before the fader), POST FADER (immediately after the fader), or POST ON (immediately after the STEREO [ON] key).
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Patch Editor window
Here you can assign the input/output port for each channel, its direct output, and its insert-in/out.
This window is divided into INPUT PATCH, OUTPUT PATCH, INPUT INSERT PATCH, OUTPUT INSERT PATCH,
DIRECT OUT PATCH, and PATCH LIST pages. To switch pages, click the tabs shown in the upper part of the window.

INPUT PATCH page

Here you can select the input port that is assigned to the input of each input channel. Except for the fact that you can
resize the window, the basic operation is the same as in the PM5D’s INPUT PATCH screen.

OUTPUT PATCH page

Here you can select the output port that is assigned to the input of each output channel. Except for the fact that you
can resize the window, the basic operation is the same as in the PM5D’s OUTPUT PATCH screen.
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INPUT INSERT PATCH page

Here you can assign input/output ports to the insert-in/out of each input channel. Select the output port in the left
side of the screen, and the input port in the right side of the screen. Except for the fact that you can resize the window, the basic operation is the same as in the PM5D’s INPUT INSERT PATCH screen.

OUTPUT INSERT PATCH page

Here you can assign input/output ports to the insert-in/out of each output channel. Select the output port in the left
side of the screen, and the input port in the right side of the screen. Except for the fact that you can resize the window, the basic operation is the same as in the PM5D’s OUTPUT INSERT PATCH screen.
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DIRECT OUTPUT PATCH page

Here you can select the output port that will directly output each input channel. Except for the fact that you can
resize the window, the basic operation is the same as in the PM5D’s DIRECT OUTPUT PATCH screen.

PATCH LIST page

Here you can view and edit the input patch and output patch settings. Input patch, output patch, and channel name
data that was written to a CSV file by the PM5D itself can also be loaded into this page. Conversely, the settings in
this page can be written to a CSV file that can be loaded into the PM5D.
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6

1

2

7

3

4

5

A Input channel number
B Input channel name
This is the number and name of the input channel. You can click the channel name box to edit the name in this
page.

C Input port
This shows the input port assigned to the input channel. You can click this box and choose the input port from
the popup menu that appears.

D Output channel number
This is the number of the output channel.

E Output port
This shows the output port assigned to the output channel. You can click this box and choose the output port
from the popup menu that appears.

F IMPORT (Import a CSV file)
Input patch, output patch, and channel name data from CSV files written by the PM5D can be loaded into the
PATCH LIST page by clicking this button.
When you click this button, a dialog box will appear as shown at right,
allowing you to specify the folder containing the CSV files you want to
load.
Specify the folder that contains CSV files written by the PM5D, and
click the OK button. If the specified folder contains CSV files to which
input patch, output patch, and channel name data was written, that
data will be loaded into the PATCH LIST page.
NOTE

If the specified folder does not contain the necessary CSV file,
the settings in the PATCH LIST page will not change. For
example if the folder contains only an input patch CSV file, only
the input patch settings of the PATCH LIST page will be loaded,
and the remaining settings will not change.

G EXPORT (Export a CSV file)
By clicking this button, input patch, output patch, and channel name data can be written to a CSV file that can be
loaded by the PM5D.
When you click this button a dialog box will appear, allowing you to specify a folder for the exported CSV files.
Specify the folder in which the CSV files will be saved, and click the OK button. Separate CSV files containing the
input patch, output patch, and channel name data will be saved in the folder you specified. You can use a memory
card to load these CSV files into the PM5D.
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Surround Editor window

Here you can make surround panning settings for the two currently selected input channels.

1

2

3

4

5

A SELECT (Channel selection)
This area displays the name and number of the two channels selected for operations (two adjacent odd-numbered/even-numbered input channels, a ST IN channel, or an FX RTN channel). To switch channels, use the
SELECT button or the / buttons at left and right. You can also edit the channel name in the text box.

B PAIR
Indicates the pair status of the two selected channels. If an input channel is selected, you can click the heart symbol to enable/disable pairing.

C LINK
Specifies whether movement of the sound image will be linked for the two selected channels. If this button is on,
the sound image of the two channels will be linked according to the link pattern you select using LINK PATTERN
SELECT buttons 1–8.

D LINK PATTERN SELECT
These buttons select link patterns 1–8. The currently selected pattern is shown graphically at the left.

E SURROUND MODE
This indicates the currently selected surround mode. You can click this area to switch the mode.
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9
J

8
6

7
K

F DIVERGENCE
These controls specify the proportion at which the signals are sent to each surround bus
when the input channel is positioned in the center. The operable parameters will change as
follows, according to the surround mode that is currently selected.

• Surround mode= 3-1ch/5.1ch
The F knob will be operable, allowing you to adjust the front divergence. Use this knob to
specify the proportion (0–100) at which a signal positioned in the center will be sent to
the center bus (C) and the left/right buses (L, R).

• Surround mode= 6.1ch
The F knob and R knob will be operable, allowing you to adjust the front and rear divergence separately. Use these two knobs to specify the proportion (0–100) at which a signal
positioned in the center will be sent to the center buses (C, S, Bs) and the left/right buses
(L, R, Ls, Rs). In addition, a LINK button that links front and rear divergence is displayed
between the F knob and R knob. If you turn the LINK button on, the value of the F knob
will be copied to the R knob, and the two knobs will be linked.

G LFE (Low Frequency Effect)
Use the LFE knob to adjust the level of the signal sent from the input channel to the subwoofer LFE bus, over a
range of –∞ to 0 dB. The ON/OFF button is an on/off switch for sending to the MIX bus assigned to the LFE
channel.

H Grid
Here you can specify the surround panning of the currently selected input channel, centered on the listening
point. The current setting is indicated by a O symbol. You can drag this symbol up, down, left, or right to move
the panning.

I PANNING buttons
These buttons correspond to each surround bus. Speaker icons are displayed to indicate the surround buses that
are available for the current surround mode.

J SURROUND BUS ON (Surround bus on/off)
These buttons are on/off switches for the signal sent from the currently selected input channel to the corresponding surround bus. You can click the surround bus name buttons at left to move the panning to the position of the
corresponding surround bus.

K PAN POSITION
The surround panning of the currently selected input channel is shown here as front/rear left/right coordinate
values.
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GEQ window

In this window you can select the insertion destination of GEQ modules 1–12, and edit the parameters.

1

2

3

4

5

A MODULE (Module selection)
Selects the GEQ module that you want to edit or view.

B INSERT (Insert destination)
Select one of the following as the insert destination for the currently selected GEQ module.
NONE
INS CH1...INS CH48
INS STIN1L, INS STIN1R...INS STIN4R
INS MIX1...INS MIX24
INS MTX1...INS MTX8
INS STAL, INS STAR
INS STBL, INS STBR
INS MONL, INS MONR, INS MONC

Not inserted
Input channel 1–48 insert in/out
ST IN channel 1–4 (L/R) insert in/out
MIX channel 1–24 insert in/out
MATRIX channel 1–8 insert in/out
STEREO A channel (L/R) insert in/out
STEREO B channel (L/R) insert in/out
MONITOR channel (L/R/C) insert in/out

C ON (GEQ on/off)
Switches the currently selected GEQ module on/off.

D LINK
This button links the settings of the adjacent odd-numbered/even-numbered GEQ modules. When you click this
button, a window will appear, asking you to confirm the operation. Click the appropriate button to choose the
source/destination module for the parameters that will be copied. If you click the RESET BOTH button, the
parameters of both modules will be reset to their default value.

E LIBRARY
This button displays the GEQ LIBRARY window.
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6

8
7
9

F GEQ graph
This graph shows the response of the currently selected GEQ module.

G GEQ faders
These faders cut/boost the frequency bands of the GEQ module. The value of each fader is shown in the numerical box below it.

H LIMIT
The range and direction of adjustment controlled by the faders can be selected from the following: ±15 dB,
±12 dB, ±6 dB (these are valid in both the boost and cut directions), or –24 dB (valid only in the cut direction).

I EQ FLAT
This button resets all GEQ faders to the 0 dB position.
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Effect Editor window

Here you can select the effect type for internal effects 1–8, edit the parameters, and specify the input/output patching.
NOTE

You can also open multiple Effect Editor windows to simultaneously view the settings of different-numbered internal effects. However, the PM5D itself will be linked only with parameter edits performed in the
window you opened first. (Parameter edits performed in the PM5D’s own screen will be valid.)

1

2

3

4

A EFFECT No. (Effect number)
Selects the number (1–8) of the internal effect you want to edit.
HINT

Alternatively, you can use the Menu bar to choose [Windows] menu → [Effect Editor], and select an internal effect 1–8 from the sub-menu.

B EFFECT NAME
Indicates the title of the effect selected for internal effect 1–8.

C EFFECT TYPE
Indicates the currently selected effect type. You can also switch the effect type from this window. To do so, click
the text box, and select the desired effect type from the popup menu that appears.

D LIBRARY
This button accesses the effect library. Clicking this button will open the EFFECT page of the LIBRARY window.
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E Effect parameters
This area shows the effect parameters and knobs for the
currently selected effect type.

5

6

7

8

9

F Input meter
Indicates the level of the signal being input to the internal effect.

G Input patch
Click the L CHANNEL or R CHANNEL area, and choose one of the following as the signal route that will be
patched to the L/R input channels of the internal effect.
––
MIX 1...MIX24
INSCH1...INSCH48
INSSTIN1L, INSSTIN1R...INSSTIN4R
INSMIX1...INSMIX24
INSMTX1...INSMTX8
INSSTAL, INSSTAR
INSSTAL, INSSTAR
INSMONL, INSMONR, INSMONC

Not inserted
Output of MIX channels 1–24
Insert Out of input channels 1–48
Insert Out of ST IN channels 1–4 (L/R)
Insert Out of MIX channels 1–24
Insert Out of MATRIX channels 1–8
STEREO A channel (L/R) insert out
STEREO B channel (L/R) insert out
MONITOR channel (L/R/C) insert out

If you select INSCH or INSSTIN as the insert-destination, the name of the channel is shown in the box immediately below.
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H Output meter
Indicates the level of the signal being output from the internal effect.

I Output patch
Click the L CHANNEL or R CHANNEL area, and choose one of the following as the signal route that will be
patched to the L/R output channels of the internal effect.
––
CH 1...CH48
STIN1L, STIN1R...STIN4R
FXRTN1L, FXRTN1R...FXRTN4R
INSCH1...INSCH48
INSSTIN1L, INSSTIN1R...INSSTIN4R
INSMIX1...INSMIX24
INSMTX1...INSMTX8
INSSTAL, INSSTAR
INSSTAL, INSSTAR
INSMONL, INSMONR, INSMONC

Not inserted
Input channel 1–48 input
ST IN channel 1–4 (L/R) input
FX RTN channel 1–4 (L/R) input
Input channel 1–48 insert in
ST IN channel 1–4 (L/R) insert in
MIX channel 1–24 insert in
MATRIX channel 1–8 insert in
STEREO A channel (L/R) insert in
STEREO B channel (L/R) insert in
MONITOR channel (L/R/C) insert in

If you select CH, STIN, FXRTN, or INSSTIN as the insert-destination, the name of the channel is shown in the
box immediately below.

J GR meter

J

If “044 M.BAND DYNA” or “045 M.BAND COMP” are selected as the effect type,
this indicates the gain reduction amount for the H (HIGH), M (MID), and L
(LOW) bands.

K SOLO
If “044 M.BAND DYNA” or “045 M.BAND COMP” are selected as the effect type,
these buttons allow you to monitor only the specified band from the three bands
HIGH, MID, and LOW.

K
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L

N M

O

P

L MIX BALANCE
Adjusts the balance of the effect sound relative to the original sound. 0 (%) outputs only the original sound, and
100 (%) outputs only the effect sound.

M BYPASS
This button temporarily bypasses the effect.

N CUE
This button cue-monitors the output of the currently selected effect.

O TEMPO
If a tempo-type or modulation-type effect is selected, this allows you to adjust time-related parameters such as
DELAY (delay time) and FREQ. (modulation speed).
To set the value of the TEMPO parameter, you can either input the BPM (Beats Per Minute) in the numerical box,
or repeatedly click the TAP TEMPO button at the desired tempo.
If the MIDI CLK button is on, the TEMPO parameter value will synchronize to the MIDI timing clock being
received from the MIDI port.

P PLAY/REC (Play/Record) buttons
If “042 FREEZE” is selected as the effect type, you can use these buttons to record and play back the signal being
input to the effect.
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DCA/Mute Group window
In this window you can select the channels that will be assigned to each DCA group and mute group. This window is
divided into two pages; the DCA GROUP ASSIGN page and the MUTE GROUP ASSIGN page.

DCA GROUP ASSIGN page

Here you can specify the channels that will be assigned to DCA groups 1–8. The upper part of the screen lets you
assign input channels to DCA groups, and the lower part of the screen lets you assign output channels to DCA
groups.
Except for the fact that assignments for both input channels and output channels can be made in a single screen, and
the fact that the screen can be resized vertically and horizontally, basic operation here is the same as in the PM5D’s
DCA GROUP ASSIGN screen.

1 2

3

4

A DCA group
This is the number of the DCA group.

B DCA group name
This is the name of the DCA group. You can also click the mouse on this area to edit the name.
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C Grid
This grid lets you assign channels (horizontal rows) to DCA groups (vertical columns). Currently-patched grids
are indicated by a
symbol. To enable or disable an assignment, click the desired grid.

D CLEAR
These buttons clear all input channels and output channels assigned to the corresponding DCA group. When you
click one of these buttons a window will appear, asking you to confirm the operation. To execute the Clear operation, click the OK button.
Clicking the CLEAR button for input channel DCA groups 7/8 will not affect the output channel assignments.
(The converse also applies.)

MUTE GROUP ASSIGN page

Here you can specify the channels that will be assigned to mute groups 1–8. The upper part of the screen lets you
assign input channels to mute groups, and the lower part of the screen lets you assign output channels to mute
groups.
Except for the fact that assignments for both input channels and output channels can be made in a single screen, and
the fact that the screen can be resized vertically and horizontally, basic operation here is the same as in the PM5D’s
MUTE GROUP ASSIGN screen.
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1 2

3

5

4

A Mute group
This area shows the mute group number.

B MUTE MASTER (Mute master)
These buttons enable/disable each input channel or output channel mute group.

C Grid
This grid lets you assign channels (horizontal rows) to mute groups (vertical columns). Currently-patched grids
are indicated by a
symbol. To enable or disable an assignment, click the desired grid.

D MUTE SAFE ON (Mute Safe on/off)
These buttons switch Mute Safe on/off for each channel. Channels for which this button is on will be excluded
from mute groups.

E CLEAR
These buttons clear all input channels and output channels assigned to the corresponding mute group. When you
click one of these buttons a window will appear, asking you to confirm the operation. To execute the Clear operation, click the OK button.
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Scene window
Here you can manage scene memories, and make various settings related to scene recall operations.
This window is divided into SCENE MEMORY, EVENT LIST, RECALL SAFE, and FADE TIME pages. To switch
pages, click the tabs shown in the upper part of the window.

SCENE MEMORY page

Here you can edit the PM5D’s scene memories. You can also load scene library files from a memory card or from a
drive of your computer, and edit them. In this case, you can re-save all scenes to a file after editing, recall just a
desired scene, or copy a desired scene to the scene memory of the PM5D itself.

3

4

A OPEN (Open a file)
Opens a scene library file located on a drive of
your computer.

5
1
2

B CLOSE (Close a file)
Closes the currently-open scene library file.

C SAVE
Saves the currently-open scene library file on a
drive of your computer.

6

D SAVE AS (Save as a different
name)
Saves the currently-open scene library file under
a different name on a drive of your computer.

E File name
Indicates the file name of the currently-open
scene library.
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F FILE
This area lists the scenes in the file you opened using the OPEN button ( 1). The list includes the following items.
HINT

To view items that are not currently shown, scroll the list to the right. The boundary lines in the center of
the window can be dragged toward the right to expand the file list display area as shown below.

7

8

9

J

K

G No. (Scene number)
This is the scene number 000–500.

H TITLE
This is the scene title. You can also double-click this area and edit the title.

I PROTECT
Turns the protection setting on/off for each scene. This area displays a lock icon for protected scenes; these scenes
cannot be overwritten, nor their title edited. Read-only scenes are indicated by “READ” displayed in this column.

J SEL. RECALL (Selective recall)
Switches the selective recall setting on/off for each scene. Selective recall using Safe parameters is enabled for
scenes for which this column indicates “SAFE,” and selective recall using Recall parameters is enabled for scenes
for which this column indicates “RECALL.”

K Library link
These columns indicates the number and title of the INPUT PATCH library, OUTPUT PATCH library, and HA
library that are linked to each scene. (With the default column width of the list, only the library number is
shown.) You can click the numerical area and specify the linked library from the popup menu that appears.

L

M

N

L COMMENT
This column shows the comment assigned to each scene. You can also double-click this column and edit the comment.

M TIME STAMP
Indicates the time at which the scene was last stored, in the format of month/day/year/hours/minutes/seconds.
This column is only for display, and cannot be edited.

N MIDI EVENT
In this column, the MIDI event that is transmitted from the MIDI OUT connector when the scene is recalled can
be viewed and edited in hexadecimal form. To edit a MIDI event, click the two-digit hexadecimal value you want
to edit, and choose the desired value from the popup menu that appears.
HINT

• If you choose “NOP” from the popup menu, that two-digital hexadecimal value will be ignored.
• If you choose “END” from the popup menu, all subsequent hexadecimal values will be ignored.
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O

P

Q

O TX (MIDI event transmission)
If you click this column to make the “TX” indication appear, transmission will be enabled for the MIDI event
specified for this scene.

P GPI OUT CONTROL
Specifies the polarity (high-active/low-active) and transmission method (tally/trigger) of the signal that is sent
from GPI OUT ports 1–12 when the scene is recalled. You can also click these columns to edit the setting. You can
choose from the following settings.
Display
None

Polarity
Disabled

Transmission method

High active

Tally

Low active

Tally

High active

Trigger

Low active

Trigger

Q REMOTE TRANSPORT
These columns indicate the MMC/RS422 transport command that will be executed when you recall the scene.
The left column indicates the protocol (MMC or RS422), and the right column indicates the type of command.
You can click an item and choose the desired protocol or command from the popup menu that appears.

S
T

R

U
V
W

R INTERNAL DATA
This area shows the PM5D’s scene memory contents. The items displayed are the same as in the FILE list ( 6).
As desired, you can copy single or multiple scenes between the FILE list and the INTERNAL DATA list, and copy
or move them to a different location within a list.
To do this, use the following methods to select the scene(s) that you want to copy or move.
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• To select a single scene
Click the line containing the desired scene.

• To select multiple consecutive scenes
Click the first scene to select it; then hold down the <Shift> key and
click the last scene.

• To select multiple non-consecutive scenes
Click the first scene; then hold down the <Ctrl> key (
key) and
click each of the remaining scenes.
When you have selected the scene(s) that you want to move or copy,
drag them to the desired location in the other list (if you’re copying
between lists) or in the same list (if you’re copying/moving within the
same list).

• To copy scenes (overwriting the destination)
Drag the copy-source scene(s) to the desired line in the other list or to
another line in the same list. At this time, a ® symbol will appear at
the right of the scene number.
When you release the mouse in this state, a dialog box will appear,
asking you to confirm the Save operation. If you click the OK button,
the copy-source scene(s) will be overwritten onto the copy-destination scenes, and the copy-source scene(s) will remain unchanged. (If
the copy-source selection contains multiple scenes, the data will be overwritten onto consecutive scenes starting at that scene.)

• To move scenes
Within the same list, you can move the selected scene(s) to another
location to rearrange the order of the scenes in the list. To do this,
drag the selected scene(s) to a location between two other lines in the
same list. At this time, a
symbol will appear between the lines.
When you release the mouse button in this state, the selected scene(s)
will move to that location, and the scene numbers will also change
accordingly. (If the move-source selection contains multiple scenes,
those scenes will be inserted consecutively at the location you specify.)

S STORE
Stores the current settings to the scene that is selected in the list.

T RECALL
Recalls the settings of the scene selected in the list.

U CLEAR
Clears the scene(s) selected in the list. (The title of the cleared scene(s) will be reset to [ No Data! ].)

V UNDO
Cancels the last-performed scene recall, store, copy, or move operation.

W PROTECT
Turns on the Protect setting for the scene(s) selected in the list.
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EVENT LIST page

In this page you can see how the scenes registered in the PM5D’s EVENT LIST screen will be switched according to
the progression of time code or according to the elapsed time since the most recent Recall operation.
NOTE

• This page functions as a viewer of the PM5D’s EVENT LIST screen. You cannot register or recall
events from within this page.
• In order for the EVENT LIST page to be synchronized with the EVENT LIST screen of the PM5D itself,
PM5D Editor must be synchronized with the PM5D.

1

2

3

A No. (Number)
This column indicates the number of each event registered in the event list.

B EVENT TRIGGER
This column indicates the recall condition specified for each event. This shows an hour:minute:second:frame
value for scenes that will be recalled at a specific time code, a value in seconds for scenes that are recalled after a
specified time has elapsed after the preceding event was executed, or [MANUAL] for scenes that are recalled manually.

C SCENE TITLE
This column indicates the number and title of the scene that will be recalled.
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RECALL SAFE page

Here you can make settings for the Recall Safe function that excludes only specific channels from recall operations of
all scenes.
Except for the fact that there is no PASTE button for copying and pasting parameter settings from the SELECTIVE
RECALL screen, the display and operations within this page are the same as in the PM5D’s RECALL SAFE screen.

FADE TIME page

Here you can make settings for the Fade function that adjusts the time over which fader and pan will reach their new
values when a scene is recalled. The settings of the Fade function are independent for each scene.
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1

2

A FADING ENABLE (Fade function enable/disable)
Switches the Fade function for fader levels between enabled and disabled.

B INPUT CHANNEL PANNING ENABLE (Input channel panning enable/disable)
Switches the Fade function for input channel pan (balance) parameters between enabled and disabled. If this button is on, you can use the two buttons located at the right to select the input channels to which this setting will
apply.

• When the ALL INPUT CHANNEL button is on
The Fade function will apply to the pan (balance) parameter of all input channels.

• When the SAME AS FADING button is on
The Fade function will apply to the pan (balance) parameter of input channels for which the Fade function is
turned on in 5.

3

4

5

C SET ALL
This button lets you enable all Fade function settings with one click. This can be operated independently for all
input channels and DCA groups, or for all output channels.

D CLEAR ALL
This button lets you disable all Fade function settings with one click. This can be operated independently for all
input channels and DCA groups, or for all output channels.

E Channel settings
Here you can specify the Fade function on/off status, the fade time, and the
offset time for each input channel, output channel, and DCA group.
To edit the fade time or offset time value, click the numerical box and drag
upward or downward.
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Library window

Here you can edit the PM5D’s various libraries. You can also load library files that were saved on a drive of your computer, edit the order or title of library items, recall the desired library data, or copy desired library data to a library
within the PM5D.
This window is divided into INPUT CH, OUTPUT CH, GATE, COMP, INPUT EQ, OUTPUT EQ, INPUT PATCH,
OUTPUT PATCH, EFFECT, GEQ, and HA pages; to switch pages, click the tabs located at the top of the window. The
editing procedure is the same in all pages. The explanation here uses the example of the INPUT CH page.

3

4

A OPEN (Open a file)
Opens a library file located on a drive of your
computer. Use this when you want to edit
library data that you’ve saved on a memory card.

5
1
2

B CLOSE (Close a file)
Closes the currently-open library file.

C SAVE
Saves the currently-open library file on a drive of
your computer. Use this to re-save an edited
library on a memory card, or to create a backup
on the hard disk of your computer.

6

D SAVE AS (Save under a different
name)
Saves the currently-open library file under a different name on a drive of your computer.

E File name
Indicates the file name of the currently-open
library.

F FILE
This list shows the contents of the data in the library file you opened using the OPEN button ( 1). The list
includes the following items.
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7 8

9
K
L

J

M
N

G No. (Number)
This column indicates the number of each item in the library.

H TITLE
This column indicates the title assigned to each library item. You can also double-click this area and edit the title.

I PROTECT
This indicates the Protect setting on/off. This area displays a lock icon for protected data; this data cannot be overwritten, nor its title edited. Read-only data is indicated by “READ” displayed in this column.

J INTERNAL DATA
This area shows the PM5D’s library contents. The items displayed are the same as in the FILE list ( 6).
As desired, you can copy single or multiple items between the FILE list and the INTERNAL DATA list, and copy
or move them to a different location within a list. The procedure is the same as in the SCENE MEMORY page of
the Scene window (➥ p.55).

K STORE
Stores the current settings to the data item that is selected in the list.

L RECALL
Recalls the data item that is selected in the list.

M CLEAR
Clears the data item(s) selected in the list. (The title of the cleared item(s) will be reset to [ No Data! ].)

N UNDO
Cancels the last-performed library recall, store, copy, or move operation.
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Meter window

Here you can view the signal levels within the PM5D, or the amount of gain reduction produced by the internal compressors and gates. This lets you check signal presence, overload status, and compressor/gate operation from your computer.
This window is divided into INPUT METER, OUTPUT METER, INPUT GR, and OUTPUT GR pages. To switch
pages, click the tabs shown in the upper part of the window.
The displayed content and operation in each page is the same as the various screens of the PM5D’s METER function.
NOTE

In order to view the PM5D’s signal levels in the Meter window, make sure that PM5D Editor and the PM5D
itself are synchronized.

Timecode Counter window
This window displays the time code (LTC, MTC) that the PM5D itself is
receiving or generating, in units of hours/minutes/seconds/frames. This
is the same time code as displayed in the PM5D’s fixed display screen and
in the EVENT LIST screen.

NOTE

In order for the Timecode Counter window to display the time code that the PM5D itself is receiving/generating, PM5D Editor and the PM5D must be synchronized.

Sync window
Synchronization between the PM5D itself and PM5D Editor can be switched on/off in
this window. This has the same function as the [Synchronization] menu. Click the
ONLINE button to switch to off-line, or click the OFFLINE button to switch to on-line.
If you click the RE-SYNC button, the Synchronization dialog box will appear (➥ p.3).
The current scene number is also displayed in this window.
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Keyboard Shortcuts
Menu

File menu

Edit menu

Windows menu

Library window or
SCENE MEMORY page
of the Scene window

Action

Windows

Macintosh

Creates a new Session

Ctrl+N

+N

Opens a previously saved Session

Ctrl+O

+O

Saves the current Session

Ctrl+S

+S

Undo

Ctrl+Z

+Z

Redo

Ctrl+Y

+Y

Closes the active window

Ctrl+W

+W

Closes all windows

Ctrl+Alt+W

+Option+W

Opens the Sync window

Ctrl+1

+1

Opens the INPUT CH (CH1-24) window

Ctrl+2

+2

Opens the INPUT CH (CH25-48) window

Ctrl+Alt+2

+Option+2

Opens the Selected Channel window

Ctrl+3

+3

Opens the Library window

Ctrl+4

+4

Opens the Patch Editor window

Ctrl+5

+5

Opens the Surround Editor window

Ctrl+6

+6

Opens the Timecode Counter window

Ctrl+7

+7

Opens the Effect Editor window

Ctrl+8

+8

Opens the Meter window

Ctrl+9

+9

Opens the GEQ Editor window

Ctrl+0

+0

Opens the DCA/Mute Group window

Ctrl+Alt+1

+Option+1

Opens the Scene window

Ctrl+Alt+3

+Option+3

Selects consecutive multiple items (memories)

Shift+click

shift+click

Selects non-consecutive multiple items (memories)

Ctrl+click

+click

Selects all memories in a section

Ctrl+A

+A
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Index
A
ALL INPUT CHANNEL ................ 59

B
Bus Setup .......................................... 3
BYPASS .......................................... 49

C
CH to MIX ..................................... 28
Channel to mix .............................. 28
CLEAR ...................................... 56, 61
CLEAR ALL .................................... 59
CLOSE ...................................... 53, 60
COMMENT ................................... 54
CSV file
Export ....................................... 41
Import ...................................... 41
Ctrl ( ) + click ................................ 5
Ctrl ( ) +Shift+Click ..................... 5

D
DCA fader ...................................... 19
DCA group ..................................... 50
DCA GROUP ASSIGN page ......... 50
DCA window ................................. 19
DCA/MUTE GROUP window
DCA GROUP ASSIGN page ... 50
MUTE GROUP ASSIGN page 51
DCA/Mute Group window ........... 50
DIRECT OUTPUT PATCH page . 40
DIVERGENCE ............................... 43

File
Close ....................................53, 60
Open ....................................53, 60
FX RTN window ............................ 11

G

F
Fade ................................................ 58
Fade function enable/disable ......... 59
FADE TIME page ........................... 58
FADING ENABLE ......................... 59
FILE .......................................... 54, 60

Pair Mode .........................................3
Pan Nominal Position ......................3
PAN POSITION .............................43
Patch Editor window .....................38
DIRECT OUTPUT PATCH page

........................................40

GEQ faders ..................................... 45
GEQ graph ..................................... 45
GEQ window ................................. 44
GPI OUT CONTROL ................... 55

I
IMPORT ........................................ 41
INPUT CH window ........................ 6
INPUT CHANNEL PANNING
ENABLE .......................... 59
Input channel panning enable/
disable ............................. 59
INPUT INSERT PATCH page ...... 39
INPUT PATCH page ..................... 38
INTERNAL DATA ...................55, 61

K

INPUT INSERT PATCH page .39
INPUT PATCH page ...............38
OUTPUT INSERT PATCH page

........................................39
OUTPUT PATCH page ...........38
PATCH LIST page ....................40
PATCH LIST page ..........................40
PLAY/REC ......................................49
PROTECT ..........................54, 56, 61

R
RECALL ....................................56, 61
Recall Safe .......................................58
RECALL SAFE page .......................58
REDO ................................................5
REMOTE TRANSPORT ................55
Re-synchronize .................................3

Keyboard Shortcuts ....................... 63

S

L
LFE ................................................. 43
Library link .................................... 54
Library window ............................. 60
LIMIT ............................................. 45
LINK PATTERN SELECT ............. 42
Low Frequency Effect .................... 43

E
Effect
GR meter .................................. 48
SOLO ........................................ 48
Effect Editor window ..................... 46
Effect parameters ........................... 47
EFFECT TYPE ............................... 46
EQ FLAT ........................................ 45
EVENT LIST page .......................... 57
EVENT TRIGGER ......................... 57
EXPORT ......................................... 41

P

M
MATRIX window .......................... 15
Meter window ................................ 62
MIDI EVENT ................................ 54
MIDI event transmission .............. 55
MIX BALANCE ............................. 49
MIX to MATRIX ........................... 33
MIX window .................................. 13
MODULE ...................................... 44
Mute group .................................... 52
MUTE GROUP ASSIGN page ...... 51
MUTE MASTER ............................ 52
MUTE SAFE ON/OFF .................. 52

O
Offline Edit ...................................... 3
OPEN ........................................53, 60
OUTPUT INSERT PATCH page .. 39
OUTPUT PATCH page ................ 38
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SAME AS FADING ........................59
SAVE .........................................53, 60
SAVE AS ...................................53, 60
Save as a different name ...........53
Save under a different name ....60
SCENE MEMORY page .................53
Scene window .................................53
EVENT LIST page ....................57
FADE TIME page .....................58
RECALL SAFE page .................58
SCENE MEMORY page ...........53
SEL ..................................................54
SEL. RECALL .................................54
Selected Channel window ..............20
Channel selection .....................20
Channel to mix .........................28
COMPRESSOR ........................23
DCA GROUP / MUTE GROUP /
SAFE ........................26, 31
DELAY ......................................26
EQUALIZER .......................25, 30
GATE ........................................21
HA gain/phase/high-pass filter 21
Input channel ...........................20
INSERT .....................................24
M/S DECODE ..........................26
MATRIX channel .....................34
MIX channel .............................29
MIX to MATRIX ......................33
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Pan / Fader ............. 27, 32, 35, 36
STEREO A/B channel .............. 35
STEREO to MATRIX ............... 37
Selective recall ................................ 54
Sessions ............................................ 4
SET ALL ......................................... 59
Setup
Console ....................................... 3
System ........................................ 2
ST IN window .................................. 9
Stereo B ............................................ 3
STEREO to MATRIX .................... 37
STEREO window ........................... 17
STORE ...................................... 56, 61
Surround Bus Allocation ................. 3
SURROUND BUS ON/OFF .......... 43
Surround Editor window .............. 42
Surround Mode ......................... 3, 42
Sync window .................................. 62
Synchronize ...................................... 3

T
Tabs .................................................. 4
TEMPO .......................................... 49
TIME STAMP ................................ 54
Timecode Counter window .......... 62
TX ................................................... 55

U
UNDO .................................. 5, 56, 61

Y
Yamaha Pro Audio Global Site ....... 1
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